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Mode d’emploi du Saver EVO
Le logiciel Saver EVO vous permet de récupérer les données d’événements de défibrillation depuis votre HeartSine 
samaritan PAD et la carte mémoire PDU. Saver EVO vous permet également de gérer les données d’évènements 
enregistrées sur le PC afin de permettre leur impression ou leur importation et exportation vers d’autres utilisateurs de 
Saver et Saver EVO.

Saver EVO est doté d'une licence logicielle permettant l’installation et l’utilisation du logiciel sur un seul PC sous 
Microsoft Windows (de préférence Windows 10).

Téléchargement à partir du site Internet
L'installation de Saver EVO peut nécessiter l’autorisation de l’administrateur - le cas échéant, contactez l’administrateur 
du système/le fournisseur de services informatiques.

1.	 	Rendez-vous sur le site heartsine.com pour télécharger le logiciel Saver EVO de votre région.

2.	 	Une fois le téléchargement terminé, exécutez « SaverEVO_setup.exe » pour installer Saver EVO. (Suivez les 
instructions à l’écran.)

3.	 	Lisez l’accord de licence de l’utilisateur. Vous devez accepter les conditions du présent accord pour installer le 
logiciel. Pour accepter les termes, cliquez sur le bouton « Next » (Suivant).

4.	 	Saver EVO sera installé à l’emplacement par défaut selon la configuration standard. Cliquez sur le bouton « I agree » 
(J’accepte) pour accepter. Les paramètres par défaut ne doivent pas être modifiés à moins d’être un utilisateur confirmé.

5.	 	Si une certification pilote vous est demandée, cliquez sur le bouton « Continue anyway » ( Continuer).

Guide d’utilisation rapide
Pour récupérer les données d’évènements de défibrillation enregistrées depuis le HeartSine samaritan PAD ou la carte 
mémoire PDU :

1.	 	Connecter le dispositif concerné à un PC.

2.	 	Ouvrez le logiciel Saver EVO.

3.	 	Cliquez sur le bouton  ou le bouton .

4.	 	Cliquez sur le bouton  pour afficher une liste des évènements sauvegardés.

5.	 	Sélectionnez l’évènement enregistré souhaité dans la liste.

6.	 	Cliquez sur le bouton  pour afficher l’évènement.

7.	 	Cliquez sur le bouton  et saisissez les informations du patient nécessaires pour enregistrer l’évènement sur le PC. 

8.	 	Le cas échéant, cliquez sur  pour imprimer l’enregistrement de l’évènement.
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Utilisation du Saver EVO 
L’écran de démarrage du Saver EVO est présenté ci-dessous.

Écran de démarrage du Saver EVO

samaritan PAD
Ouvre le menu des fonctions spécifiques au HeartSine samaritan PAD. Consultez 
la page 4 pour plus de détails

samaritan PDU
Ouvre le menu des fonctions spécifiques au PDU. Consultez la page 9 pour plus 
de détails

Manage Saved Events (Gérer 
les évènements enregistrés)

Ouvre le menu des fonctions spécifiques aux évènements enregistrés sur le PC. 
Consultez la page 12 pour plus de détails

Exit Saver EVO (Quitter 
Saver EVO)

Quitte le logiciel Saver EVO

Modification du mot de 
passe du Saver EVO

Modifie le mot de passe du Saver EVO et sélectionne la langue. Permet également 
à l’utilisateur d’afficher les informations de révision du Saver EVO

L’utilisation des menus présentés ci-dessus sera détaillée plus loin.

Utilisation du Saver EVO avec HeartSine samaritan PAD
Pour utiliser le Saver EVO avec HeartSine samaritan PAD, vous avez besoin du câble USB de transfert de données 

(normalement fourni avec votre HeartSine samaritan PAD). Si vous ne possédez pas ce câble, veuillez contacter votre 
représentant Stryker ou un distributeur agréé. Si un HeartSine Gateway est connecté à votre DAE, vous pouvez utiliser 

un câble micro-USB.

1.	 	À l’aide du câble USB de transfert de données, connectez le HeartSine samaritan PAD au port USB de votre PC. 

Ouvrez le logiciel Saver EVO.
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2.	 	Cliquez sur le bouton « samaritan PAD » pour ouvrir la fenêtre ci-dessous.

Écran d’accès à Saver EVO PAD

Pad Data (Données PAD)
Cliquez sur ce bouton pour récupérer les données d’évènements du HeartSine 
samaritan PAD. Consultez la page 5 pour plus de détails

Change PAD Settings (Modifier 
les paramètres PAD)

Cliquez sur ce bouton pour effectuer des tests de diagnostic ou modifier la 
configuration (volume et heure) sur le HeartSine samaritan PAD. Consultez la 
page 7 pour plus de détails

Back (Retour) Cliquez sur ce bouton pour revenir à l’écran de démarrage du Saver EVO

Récupération des informations des données d’événements à partir 
du HeartSine samaritan PAD
Pour récupérer les données d’évènements de la défibrillation du HeartSine samaritan PAD, assurez-vous que votre 
HeartSine samaritan PAD est connecté au PC, puis cliquez sur le bouton « PAD Data » (Données du PAD). Une recherche 
est effectuée dans la mémoire du HeartSine samaritan PAD pour afficher une liste de tous les évènements enregistrés 
comme le montre l’image ci-dessous.

Écran du journal des évènements de Saver EVO
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Les évènements affichés en vert avec un symbole  sont déjà enregistrés sur le PC.

Save All 
(Enregistrer 
tout)

Cliquez sur le bouton « Save All » (Enregistrer tout) pour enregistrer tous les évènements du 
journal d’évènements du PAD dans un fichier unique sur le PC

Remarque : les évènements enregistrés à l’aide de ce bouton ne peuvent pas être récupérés 
pour être affichés par cette version de Saver EVO. Pour récupérer les évènements de ce fichier, 
contactez l’assistance clientèle de HeartSine Technologies. Pour enregistrer les évènements 
individuellement pour une récupération ultérieure, consultez la fonction « Save All » 
(Enregistrer tout) dans la rubrique Affichage des évènements sur un HeartSine samaritan PAD, 
page 6

View (Afficher) Cliquez sur ce bouton pour afficher l’évènement sélectionné

Erase (Effacer)
Cliquez sur ce bouton pour supprimer tous les évènements du journal d’évènements du 
HeartSine samaritan PAD. Consultez la page 7 pour plus de détails sur l’effacement des données

Back (Retour) Cliquez sur ce bouton pour revenir à l’écran d’accès de Saver EVO PAD

Affichage des évènements sur un HeartSine samaritan PAD
1.	 	Pour visualiser un événement, sélectionnez-le dans la liste et cliquez sur le bouton « View » (Afficher). Une fenêtre 

affiche l’évènement de défibrillation conjointement avec son tracé ECG et le journal des évènements.

Fenêtre des informations du patient de Saver EVO PADFenêtre d’affichage des évènements de Saver EVO PAD

2.	 Vous pouvez alors choisir d’enregistrer l’évènement affiché sur le PC en cliquant sur le bouton « Save » (Enregistrer). 
Les évènements ainsi enregistrés peuvent être récupérés et affichés dans Saver EVO. Vous aurez la possibilité 
de saisir les informations permettant d’identifier le patient dans la liste des événements sauvegardés sur votre 
ordinateur. Chaque champ d’information sur le patient peut être complété, en caractères alphanumériques, ou laissé 
vide u choix.

Remarque : Une fois les données de l’évènement de défibrillation sauvegardées sur votre PC, celles-ci ne peuvent 
plus être modifiées

Saver EVO 1.3.0 Mode d’emploi
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La fenêtre d’affichage des évènements de Saver EVO propose également les boutons suivants : 

Print (Imprimer) Cliquez sur ce bouton pour imprimer l’évènement affiché dans la fenêtre

Print Preview (Aperçu 
avant impression)

Cliquez sur ce bouton pour afficher un aperçu des données imprimées

Back (Retour)
Cliquez sur ce bouton pour revenir à l’écran de la liste du journal des évènements de 
Saver EVO PAD

Effacement de la mémoire sur un HeartSine samaritan PAD
1.	 Pour effacer la mémoire d’un HeartSine samaritan PAD, cliquez sur le bouton « Erase » (Effacer). 

2.	 Par précaution, Saver EVO vous demande de saisir votre mot de passe avant d’effacer la mémoire. Une fois le mot 
de passe correct saisi, la mémoire du HeartSine samaritan PAD est effacée. Pour savoir comment modifier le mot de 
passe par défaut, veuillez consulter la rubrique Modification du mot de passe dans Saver EVO, page 14. 

	 Une fois les données des évènements du HeartSine samaritan PAD récupérées et enregistrées sur le PC, il est 
recommandé d’effacer les évènements de la mémoire du HeartSine samaritan PAD. Ainsi, vous êtes certain 
de disposer de suffisamment de mémoire pour l’enregistrement des données liées à un autre événement de 
défibrillation.

 Attention : HeartSine vous recommande de télécharger l’intégralité de la mémoire du HeartSine samaritan PAD 
avant de l’effacer. Ces informations doivent être conservées en lieu sûr pour pouvoir être consultées ultérieurement

Modification des paramètres du HeartSine samaritan PAD
Le bouton « Change PAD Settings » (Modifier les paramètres du PAD) permet de configurer les fonctions suivantes du 
HeartSine samaritan PAD :

•	Vérifier/Régler l'heure

•	Démarrer des tests de diagnostic

En outre, les utilisateurs disposant des autorisations nécessaires peuvent modifier les fonctions suivantes :

•	Volume

•	Activer/désactiver le son du métronome

1.	 	Cliquez sur le bouton « Change PAD Settings » (Modifier les paramètres du PAD) pour afficher l’écran suivant :

Fenêtre « Modifier les paramètres du PAD » de Saver EVO

Saver EVO 1.3.0 Mode d’emploi
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Check/Set PAD Time (Vérifier/Régler l’heure du PAD)
Ce bouton permet de synchroniser l’heure du HeartSine samaritan PAD avec celle du PC.

Fenêtre « Vérifier/Régler l'heure du PAD » de Saver EVO

1.	 	Cliquez sur le bouton « Synchronize » (Synchroniser) pour régler l’heure du HeartSine samaritan PAD à la même 
heure que le PC auquel il est connecté.

2.	 	Cliquez sur le bouton « Close » (Fermer) pour revenir de la fenêtre « Modifier les paramètres du PAD » de Saver EVO.

Run Diagnostic Tests (Démarrer des tests de diagnostic)
Ce bouton permet d’effectuer des tests basiques pour vérifier le fonctionnement du HeartSine samaritan PAD. La liste 
des tests de diagnostic disponibles est accessible depuis le menu déroulant, comme le montre l’image ci-dessous.

Fenêtre des tests de diagnostic du PAD de Saver EVO

Saver EVO identifie le type de dispositif PAD connecté et affiche les illustrations adaptées pour guider l’utilisateur 
pendant les tests.

Saver EVO 1.3.0 Mode d’emploi
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Edit PAD Configuration (Modifier la configuration du PAD)
Cliquez sur ce bouton pour ouvrir la fenêtre de modification de la configuration du PAD (image ci-dessous), qui vous 
permet de consulter et de modifier les paramètres du volume et du métronome, et d’afficher la version du logiciel du 
dispositif HeartSine samaritan PAD connecté. Pour confirmer les modifications, Saver Evo vous invite à saisir le mot de 
passe. Pour savoir comment modifier le mot de passe par défaut, veuillez consulter la rubrique Modification du mot de 
passe dans Saver EVO, page 14.

Fenêtre de modification de la configuration du PAD de Saver EVO

Utilisation de Saver EVO avec le PDU*
1.	 	Pour utiliser Saver EVO avec la carte mémoire samaritan PDU, vous devez insérer la carte dans un lecteur de 

carte compatible MMC/SD connecté ou intégré à un PC qui exécute Saver EVO. Veuillez noter que le système 
d’exploitation de l’ordinateur peut prendre quelques secondes, voire même plus d’une minute, pour reconnaître la 
présence d’une carte dans le lecteur. 

2.	 	Sur l’écran de démarrage, cliquez sur le bouton « samaritan PDU ». La fenêtre ci-dessous s’affiche.

Écran d’accès au PDU de Saver EVO

* samaritan PDU n’est pas disponible aux Etats-Unis et n’est plus commercialisé par HeartSine.

Saver EVO 1.3.0 Mode d’emploi
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PDU Data (Données du 
PDU)

Cliquez sur ce bouton pour récupérer les données d’évènements de la carte mémoire 
PDU. Consultez la page 10 pour plus de détails

PDU Settings 
(Paramètres du PDU)

Cliquez sur ce bouton pour afficher les paramètres de configuration. Consultez la page 
12 pour plus de détails

Back (Retour) Cliquez sur ce bouton pour revenir à l’écran de démarrage de Saver EVO

Récupération des données d’événements depuis la carte mémoire 
PDU
Assurez-vous que la carte mémoire samaritan PDU est insérée dans le lecteur de cartes SD/MMC et cliquez sur le 
bouton « PDU Data » (Données du PUD). Une liste des évènements enregistrés sur la carte mémoire s’affiche.

Écran du journal des évènements du PDU de Saver EVO

 

Les évènements avec l’horloge  sont des autotests du PDU réussis.

Les évènements affichés en vert avec un symbole sont déjà enregistrés sur le PC.

Save All (Enregistrer tout) Ce bouton est désactivé en mode PDU

View (Afficher)
Cliquez sur ce bouton pour afficher l’évènement sélectionné. Consultez la page 11 
pour plus de détails

Erase (Effacer) Ce bouton est désactivé en mode PDU

Back (Retour) Cliquez sur ce bouton pour revenir à l’écran d’accès du PDU de Saver EVO
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Affichage des évènements stockés sur un PDU 
1.	 	Pour afficher un événement, sélectionnez-le dans la liste et cliquez sur le bouton « View » (Afficher). Une fenêtre 

affiche l’évènement de défibrillation conjointement avec son tracé ECG et le journal des évènements :

Fenêtre d’affichage des évènements du PDU de Saver EVO	

2.	 L’utilisateur peut alors choisir d’enregistrer l’évènement affiché sur le PC en cliquant sur le bouton « Save » 
(Enregistrer). Il a ainsi la possibilité de saisir des informations permettant d’identifier le patient. Chaque champ 
d’information sur le patient peut être complété, en caractères alphanumériques, ou laissé vide au choix.

Fenêtre des informations du patient du PDU de Saver EVO

Remarque : Une fois les données de l’évènement de défibrillation sauvegardées sur votre PC, celles-ci ne peuvent plus 
être modifiées

La fenêtre d’affichage des évènements de Saver EVO propose également les boutons suivants : 

Print (Imprimer) Cliquez sur ce bouton pour imprimer l’évènement affiché dans la fenêtre

Print Preview (Aperçu 
avant impression)

Cliquez sur ce bouton pour afficher un aperçu des données imprimées

Back (Retour)
Cliquez sur ce bouton pour revenir à l’écran de la liste du journal des évènements du 
PDU de Saver EVO

Saver EVO 1.3.0 Mode d’emploi
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Affichage des paramètres du PDU
Cliquez sur le bouton « PDU Settings » (Paramètres du PDU) pour ouvrir l’écran de configuration du PDU. Cet écran 
affiche l’état de la batterie, le volume des haut-parleurs, les paramètres de langue et du métronome, le rythme et la 
durée de RCP, la date d’expiration, la version logicielle ainsi que le numéro de série du PDU. L’utilisateur peut voir ces 
paramètres mais ne peut pas les modifier.

Fenêtre d’affichage des paramètres du PDU de Saver EVO

Utilisation de Saver EVO avec des événements enregistrés
Le bouton « Manage Saved Events » (Gérer les évènements enregistrés) de l’écran principal de Saver EVO permet de 
consulter les données d’évènements téléchargées depuis le HeartSine samaritan PAD, la batterie samaritan Data-Pak ou 
la carte mémoire PDU afin de les enregistrer sur l’ordinateur. 

1.	 Cliquez sur ce bouton pour ouvrir la fenêtre suivante :

2.	 Sélectionnez un événement dans la liste et cliquez sur « View » (Afficher) pour ouvrir l’événement enregistré 
et afficher les données d’ECG et le journal des événements.

Saver EVO 1.3.0 Mode d’emploi
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Exportation et importation
Saver EVO est doté de fonctions qui permettent aux utilisateurs d’envoyer ou de recevoir des données d’évènements de 
défibrillation à d’autres utilisateurs du logiciel Saver EVO. Vous pouvez envoyer ou recevoir des copies des événements 
enregistrés, à l’aide des fonctions Exporter et Importer de Saver EVO.

Pour exporter les événements :
1.	 	Dans l’écran de gestion des évènements enregistrés, sélectionnez l’évènement ou un nombre d’évènements que vous 

souhaitez exporter, puis cliquez sur le bouton « Export » (Exporter).

2.	 	Vous devez préciser l’emplacement où vous souhaitez enregistrer le fichier d’exportation et vous pouvez le nommer.

3.	 	Cliquez sur le bouton « Save » (Enregistrer) pour sauvegarder le fichier à l’emplacement choisi.

Vous pouvez ensuite joindre ce fichier à un e-mail à l’aide de votre logiciel de courrier électronique et envoyer le fichier 
exporté à un autre utilisateur équipé du logiciel Saver EVO.

Les données d’événements du Saver EVO ne peuvent être visualisées que par un autre utilisateur de Saver EVO.  
Il n’est pas possible d’importer et d’afficher les données issues de Saver EVO sur la précédente version logicielle  
de Saver.

Pour importer des événements :
Pour importer des évènements et les afficher sur votre PC, vous devez enregistrer le fichier envoyé par un autre 
utilisateur de Saver ou Saver EVO sur votre PC.

1.	 	Dans l’écran de gestion des événements enregistrés de Saver EVO, cliquez sur le bouton « Import » (Importer).

2.	 	Recherchez l’emplacement où est enregistré le fichier et cliquez sur « Open » (Ouvrir).

3.	 	Les enregistrements sont ajoutés à la liste des fichiers Saver EVO de votre ordinateur.

Pour les afficher, sélectionnez un évènement dans la liste et cliquez sur le bouton « View » (Afficher).

Saver EVO importe et affiche correctement les données d’évènements exportées depuis la précédente 
version logicielle Saver.

Pour supprimer des événements sauvegardés :
Saver EVO peut supprimer les évènements enregistrés dans la mémoire de votre ordinateur. Pour supprimer les 
évènements individuellement, sélectionner le ou les évènement(s) à supprimer (il est possible de sélectionner plusieurs 
évènements) en surlignant l’évènement concerné. 

Après vous être assuré que seuls les événements à supprimer ont été sélectionnés, cliquez sur le bouton « Erase » 
(Effacer). Par précaution, Saver EVO vous demande de saisir votre mot de passe avant d’effacer la mémoire. Une fois le 
mot de passe correct saisi, la mémoire des évènements sélectionnés est effacée de votre ordinateur.

 Attention : Vérifiez que seuls les éléments que vous voulez supprimer ont été sélectionnés avant de procéder à 
l’effacement. Une fois supprimés de la mémoire de votre ordinateur, les événements ne peuvent plus être restaurés et 
toutes les informations sont perdues  

Saver EVO 1.3.0 Mode d’emploi
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Modification des paramètres de Saver EVO
Certaines fonctions de Saver EVO ne peuvent être modifiées ou effectuées qu’en saisissant un mot de passe. Les 
administrateurs peuvent ainsi restreindre l’accès à certaines fonctions du logiciel aux utilisateurs autorisés. Une fois 
Saver EVO installé, le mot de passe par défaut est « password » (mot de passe).

Pour modifier le mot de passe :

1.	 	Sur l’écran principal Saver EVO, cliquez sur le bouton « Paramètres ». La fenêtre suivante s’affiche :

Écran de modification des paramètres

2.	 	Saisissez le mot de passe actuel et cliquez sur « Confirm » (Confirmer).

3.	 	Saisissez deux fois le nouveau mot de passe et cliquez sur « Apply » (Appliquer) pour valider le changement.

4.	 Cliquez sur « OK » pour fermer la fenêtre de modification du mot de passe.

Remarque : En cas de nouvelle installation de Saver EVO, le mot de passe est réinitialisé par défaut. Toutefois, 
cette action ne supprime pas les données d’événements précédemment enregistrées

Saver EVO 1.3.0 Mode d’emploi
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Pour modifier la langue de Saver EVO : 
1.	 	Pour choisir la langue de Saver EVO, sélectionnez la langue dans le menu déroulant et cliquez sur « Apply » 

(Appliquer).

2.	 	L’écran suivante s’affiche alors et vous devez redémarrer Saver EVO pour appliquer le changement de langue.

3.	 Cliquez sur « Yes » (Oui) ou « No » (Non) pour fermer Saver EVO.

Pour vérifier les mises à jour automatiques :
1.	 Si la case est cochée, lors de chaque démarrage de Saver EVO, celui-ci tentera de se connecter au site Internet 

HeartSine pour consulter les versions les plus récentes de Saver EVO. Si une mise à jour est disponible, la fenêtre 
suivante s’affichera lors du démarrage de Saver EVO.

2.	 Cliquez sur « Yes » (Oui) ou « No » (Non) si vous souhaitez ou pas télécharger une version plus récente de Saver EVO.

Saver EVO 1.3.0 Mode d’emploi



Cyber sécurité
•	Assurez-vous que tous les correctifs de sécurité Microsoft sont appliqués sur votre ordinateur 

•	Sauvegardez régulièrement votre ordinateur (y compris les fichiers Saver EVO)

•	Il est recommandé d’installer un logiciel antivirus/anti-malware sur votre ordinateur et que celui-ci soit actif et 
actualisé

•	Utilisez un mot de passe sécurisé pour vous connecter à votre ordinateur. Le mot de passe doit inclure des lettres 
minuscules et majuscules, ainsi que des nombres et des symboles

Pour de plus amples informations, envoyez un email à heartsinesupport@stryker.com ou  
visitez notre site Internet heartsine.com

Stryker ou ses filiales sont titulaires de, utilisent ou ont déposé une demande des marques commerciales ou marques de service 
suivantes : HeartSine, HeartSine Gateway, samaritan, Saver EVO, Stryker. Toutes les autres marques commerciales sont des 
marques commerciales de leurs propriétaires ou titulaires respectifs. 
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